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collection illustrated the latest achievements of ESRI's creative and
innovative users.The map gallery was visited by thousands of
visitors.The most Popular and People's choice map display was of
The Spatially Interactive Literature Analysis System (SILAS) by
Stephen Benzek University of Redlands; followed by the Best
Overall Map display by Qatar's Unique NationWide GIS Data
Sharing by Mohamed Hamouda, The Center for GIS, UPDA State of
Qatar.
Including digital maps for the first time ever, this year's ESRI UC
Map Gallery also showcased GIS use in a captivating way.
Multimedia Map Gallery entries illustrated the results of using ESRI
technologies in a project or study but did not use ESRI software to
run the presentation itself.

ICA Award for Jack Dangermond
The International Cartographic Association (ICA) presented ESRI
President Jack Dangermond with the Carl Mannerfelt Medal this
morning. The Mannerfelt Gold Medal is the ICA's highest honor,
first awarded in 1980 to recognize extraordinary merits in
cartography including the conception, production, dissemination,
and study of maps. Dangermond is only the 11th recipient of the
medal.
Jack Dangermond was conferred with the Mannerfelt Medal to
recognize his development of new cartographic tools, the creation
of digital atlases, and his promotion of cartography. Especially
innovative is ESRI's use of maps and GIS to assist in many areas of
human activities, ranging from crisis management in disasters, such
as the recent cyclone in Myanmar, to issues of health and
geography.
ESRI President thanked the delegation, commenting: "It is such a
privilege to provide the software and tools giving our users the
capability to create real change in our world. This award exemplifies
the mission of ESRI. I can think of no better place to receive this

User Software Applications Fair, where conference attendees
dropped by to view custom maps and see demonstrations of
applications that use ESRI software to meet specific end-user
requirements. The software applications displays included the
Desktop GIS Applications, Web Based Applications and Embedded
GIS category. The overall winner was Qatar GIS from The Centre for
GIS, UPDA, State of Qatar.

International Support Council - ESRI Support Services
During ESRI User Conference 2008, ESRI Support Services had
introduced a new program “International Support Council” where
selected international support staff was involved with ESRI Support
Services during User Conference.
This council was comprised of ESRI Support Services management
and support professionals of the ESRI International Distributor
community who have a common interest in improving the
technical support experience of our customers. Involvement with
the International Support Council provides a collaborative forum
for expressing ideas and opinions to help guide the future of
International Support.
ESRI India among all International distributors was one of 11
distributors who got this opportunity to work in association with
ESRI Support Services to interact with their users World-wide.
This provided an opportunity to International distributors to see
how ESRI Inc handles their Technical Support Island, interact with
ESRI staff on a one-on-one basis and attend relevant technical
sessions related to ESRI Support Services.
As a part of “International Support Council”, members also got
opportunity to
Participate in Technical Support Island in supporting
conference attendees
=

award than here at the ESRI International User Conference, where
we are surrounded by thousands of people who use cartography in
innovative ways every day

Map Gallery / User Software Applications Fair at ESRI
UC
The 2008 ESRI UC was truly a place for GIS professionals to shine.
Major attraction at the User Conference this year was the Map
Gallery and User Software Applications Fair.
Map Gallery showcased more than 850 map products, posters and
multimedia map projects were on display. This year's inspiring
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Attend ESRI Support Services sessions on :

i.

User Advocacy Group: Introduction and Overview

ii.

ESRI Support Center: Improvements and Initiatives

iii. ESRI Support Services and International Distributor: Visibility
and Transparency
iv.

ESRI Support Services: Operations Roadmap Planning

ESRI Support Services under their ISC Program is now planning to
conduct monthly meetings with representatives of the
International Distributors' Support Units. This will continue on the
idea of active involvement to improving Support Services and the
distributor relationship with ESRI.

Technical Article

Enterprise GIS and the Smart Electric Grid
- Bill

Meehan , Director Utility Solutions, ESRI

Introduction:
With continuous rise in consumer demand,
the Electric utilities are facing serious
challenges in managing their services
efficiently and cost effectively. The odds are
that, in a few short years, electricity is going
to play a much more prominent role in
other sectors like Transportation also. As
per predictions of the CEO of a very large
electric company in the United States, the
electrification of the transportation
industry would happen in his lifetime itself.
This is noticeable from the increasing
number of hybrid vehicles being
introduced in the market and several major
automakers would be offering plug in
hybrid vehicles in less than two years. In
India, for example, Reva, Tata and
Chennai's Bavina Industries are quickly
building electric cars for the consumer
market. Should a significant rise in the use
of electricity for transportation
materializes, as it likely to happen,
demands and electric energy usage are
bound to soar. Meanwhile, the existing
electric infrastructure continues to age,
while countries like India are expanding
electric usage to vast rural areas. Within a
short period, a large percentage of skilled
workers will reach retirement age. In all
likelihood regulators outside of Europe will
institute a new Carbon Cap and Trade
system in 2009 causing electric utilities to
rethink nearly every process they perform.
Increasing 21st century customer
demands, the need for additional facility
physical security and the ever present need
to keep costs under control will force
utilities to operate differently and smarter.

Intelligent Grid and Intelligent Utility
Network etc.
The Smart Grid is not a piece of hardware
or a computer system, but rather a
concept. While there are many facets to the
concept, it really is about three things:

=

1. More effectively managing load
2. Providing significantly more automation
during restoration after an outage event
3. Providing more interaction between
providers and consumers
How a Smart Grid helps in solving the
challenges noted above
=

In order to competently deal with these
challenges, Smart Grid undeniably seems
to be a smart choice for the utilities.

What exactly is a Smart Grid:
Smart Grid is a transformed electricity
transmission and distribution network or
"grid" that uses robust two-way
communications, advanced sensors, and
distributed computers to improve the
efficiency, reliability and safety of power
delivery and use. In December 2007,
United States President George W. Bush
signed into law the Energy Independence
and Security Act (EISA). Title 13 of this law
is called Smart Grid. So the United States
Government officially recognized the term
Smart Grid. Other terms for Smart Grid are

take action to automatically reconfigure
the network in an attempt to relieve the
overloading condition. The grid can be
“self healing” by switching around
problem areas to minimize outages.

=

Interactive with consumers and
markets: A Smart Grid is interactive in
nature this and thus can enable electric
companies in understanding what
individual consumers are doing at any
given time relative to their
consumption. It also means that utilities
can provide consumers with price
signals and information about the
implications of their energy usage. For
example, customers could find out the
price (or cost) of turning on their air
conditioners. A smart grid could also
assist in detecting areas of theft of
current and taking necessary measures
to prevent it.
Adaptive to New Conditions: A Smart
Grid is adaptive to new conditions and
can facilitate the electric system to
respond to the change without human
intervention. So if a circuit were nearing
its loading limit, the “smart grid” could

=

Optimized to make best use of
resources: Electric demands tend to
spike during the hottest part of the day
and of the year. This requires electric
companies to maintain large reserves of
capacity. By allowing the grid to smooth
out the demands, utilities can better
utilize existing facilities.
Predictive and not reactive to
prevent emergencies: A smart grid
will have many thousands of sensors to
help operators in having a better
understanding of the way the system is
running. Operators will have the tools to
predict a failure before it happens and
can take appropriate action. That action
may be automatic, which even with
today's sophisticated SCADA systems
and Distribution Management Systems
does not happen and operators do most
of the switching based on their
interpretation of the situation.

How the Smart Grid Concept be
Implemented
In order to successfully implement the
concept of Smart Grid, Utilities will need to
add additional components such as:
=

Smart Meters the key to the smart grid
is the complete installation of smart
meters that are designed to measure
consumption on a very small interval of
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time (seconds or less), saves that
consumption in memory and is able to
communicate that consumption and
associated time interval back to the
utility. In addition the smart meter can
communicate energy use to the
consumer as well. Some smart meters
can automatically disconnect the load
and lock out power from flowing. In
effect the smart meter provides the
linkage between consumer behavior
and electric energy consumption.
=

=

=

=

=

=
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Energy Storage Systems these could be
enhanced batteries, fly wheels or
compressed air systems. The idea of
energy storage is to flatten the peak, so
as to allow utilities to better utilize the
most efficient and environmentally
sound generation options.
Outage Management Systems (OMS)
most OMS's use sophisticated
prediction engines based on customer
phone calls and network models to
determine outage locations. OMS's
linked to smart grid will not be based
on a prediction engine using phone
calls but on a sensor network and will
be far quicker and more accurate.
Distribution Management System
(DMS) - a DMS provides the means to
reconfigure and analyze the electric
network. In a smart grid, the DMS and
OMS will converge into more of an
automated analytical engine that
makes decisions based on the
information from the sensor network
and smart meters about loading,
predictive equipment failures and of
course outage and restoration.
Sensors (fault, voltage, current) the
smart grid will have sensors along the
distribution network that
communicate the condition of the
distribution system to the central smart
grid processors. Most electric systems
around the world have very little
communication of the state of the
system beyond the main supply
substations. In fact, in most electric
utility systems today, the utility is
virtually blind to problems in the field.
Communications Networks the key to
the smart grid is the ability to
communicate the state of the system
from the sensor network both to the
utility and to the customers. The
electric distribution system will grow
from a single network to a dual
network system; one network
representing the power system and the
other an advanced communication
network. The two systems will be
integrated.
Data Management of Meters and
Sensors - There needs to be a means of
collecting all the data from the sensors

and smart meters in order to make
decision about self healing the grid or
load shifting or just creating proper
bills. So there needs to be sophisticated
data management systems in place to
store historic and current real time data
about the system.
=

=

=

SCADA systems - Traditional SCADA
systems are early smart grid
technologies. However their reach is
usually limited to substations and a few
major distribution automation devices
like remote controlled disconnect
switches. However the data managed
by SCADA plays and important part of
any smart grid implementation.
Real time analytic engines - Smart grid
will need complex engines that analyze
the network to determine the current
state and condition of the system,
predict what may happen to the system
and to develop a plan of what to do
with the system. These engines will
need data from a variety of sources,
both managed by the utility and by
outside parties (like weather services).
Enterprise GIS - A critical part of Smart
Grid is the underlying electric and
communications network. GIS
provides the tools, applications, work
flows and integration ability to support
the smart grid.

The combination of smart meters, data
management, communication network
and applications specific to metering is
advanced metering infrastructure or AMI.
So AMI plays a key role in Smart Grid. Many
utilities begin their smart grid
implementation with AMI.

The Broader Role of Enterprise GIS
in Smart Grid
It widely recognized that GIS plays a strong
role in managing traditional electrical
transmission and distribution and
traditional telecommunications networks
today. So GIS will continue to play a strong
role in managing the smart grid by creating
an inventory of both networks. The GIS
provides the most comprehensive
inventory of the electrical distribution
network components and their spatial
location. With the addition of a
sophisticated communication network
superimposed on the electrical network,
the management of the data of the system
becomes twice as critical. Having two
separate and not related inventory systems
for power systems and communication
systems would be ineffective.
GIS will help manage the data about the
condition of utility assets. After parts of the
system go in service, utilities must maintain
the system. So they must collect and
maintain asset condition data. Some of the
condition data can come from automated
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systems and other from inspection systems.
The GIS and its mobile components allow
utilities to gather condition data. Utilities
are rapidly adopting GIS based mobile
devices for inspection and maintenance.

utilities use this combined information for a
whole host of business applications, such
as visualizing a common operating picture
to inspection and maintenance to network
analysis and planning.

The power of GIS helps utilities
understanding the relationship of its assets
to each other. Since the smart grid is two
networks (power and communications) it is
critical that utilities understand physical
and spatial relationships among all the
components. These relationships will form
the basis for some of the advanced decision
making the smart grid makes. Smart grid
must have a solid understanding of the
connectivity of both networks. GIS
provides the tools and work flows for
network modeling and advanced tracing.

From a smart grid perspective, the GIS can
visualize the electric and communications
systems and the relationships that exist
between them. It goes well beyond the
traditional “stare and compare” method
commonly used by utilities to a more “see
relationships” notion. The GIS provides a
means to monitor and express the health of
the system in an obvious way. “Show me
all the sensors that have failed to report
results in the last hour.” The GIS can show
the real time view of the grid and note
where things are changing. In effect, the
GIS (as compared to a SCADA system) can
show the complete state of the grid
represented in a realistic model of the grid
in a way that people understand.

GIS also helps in the understanding of the
relationship of the various networks in to
the surroundings. It also understands the
relationship of the systems to the
environment. This will be critical for
restoration, storm tracking and security
monitoring.
The GIS is an ideal tool to help to determine
optimal location for smart grid
components. During the roll out of smart
grid, utilities will need significant analysis to
determine the right location for sensors,
communication marshalling cabinets and a
host of other devices. They need to run
fiber optics in conduit and on poles. GIS
provides the proper means to perform
these design services, since the optimal
locations depend so heavily on the existing
infrastructure.
Finally, GIS can provide a spatial context to
the analytics and metrics of smart grid. It
can help track the metrics over time and
provide a convenient means of visualizing
trends. Since the Smart Grid is supposed to
be smart, it must have the ability to provide
advanced analytics about how the grid is
performing. It must track trends in the
performance of equipment and customer
behavior and keep track of key
performance metrics.

Why GIS is so important to Smart
Grid
Enterprise GIS is a framework or platform
that underpins an electric utility
information technology system. Other
platforms that make up the utility IT system
include SCADA, Customer Billing/Financial
Systems, and Document Management
Systems. Enterprise GIS authors or creates
spatial information about the utility assets
(poles, wires, transformers, duct banks,
customers) and serves that information to
the enterprise. The core business
applications then mash up or combine the
data served from the GIS, SCADA,
customer systems, along with other
information from outside the utility, like
traffic or weather systems or imagery. Then

Moreover, the GIS can actually control
parts of the grid. It can be the heart of a
distribution management system or at least
integrate with one. The technology can
recommend ways to get the grid back to
normal after an abnormal event. Or it can
automatically have the grid do something
different. The notion of smart grid as driven
by the GIS would help the grid adapt to
changing situations based on the
information from the thousands of sensors.
This would help prevent outages and
equipment failure. For example, in the
United States utilities do not monitor the
vast majority of distribution transformers.
So if the load on any of these transformers
rises well beyond its capability, it can fail.
With monitoring, the smart grid would be
able to determine if the transformer has
experienced past stresses and may have
lost some life. Then as the transformer
approaches a dangerous limit, the smart
grid could take preventive measures to
avoid the catastrophic failure of the
transformer. The GIS would then perform a
spatial analysis that determines the risk of
failure and the customer impact. The smart
grid algorithms in concert with the GIS
could determine whether to reduce load at
the customers' sites or reconfigure the
network to relieve the load or actually do
some preemptive switching.

The Challenges
It is hard to imagine implementing a smart
grid without a detailed and comprehensive
network model contained within the GIS.
However, utilities must face a number of
challenges to assure the effectiveness of
their smart grid program. The first is that
the data quality that exists in the GIS must
be outstanding. It is one thing to have a few
errors on a planning or asset management
map. While not desirable, it is even
somewhat tolerable to have some
inaccuracies in the GIS data that feeds

outage management systems. However, it
is not tolerable to have incorrect data in a
system that automatically controls the
electric distribution system. Errors could
result in increased outages or worse,
accidents. So utilities must carefully
examine their data updating processes and
quality assurance procedures. There are a
number of excellent standards that exist
throughout the world for the processing of
critical infrastructure data. Those standards
and processes should be tested and strictly
adhered to. Historically utilities maintained
a large backlog of documentation about
completed work in the field (as-built
sketches backlogged work orders) that are
to be posted to the GIS. So utilities must
measure the time from when a change
occurs in the field to when the change is
reflected in the GIS. For example if the
utility installs and energizes a sensor, the
GIS (and the smart grid algorithm) must
reflect the data about that sensor in a
relatively short period time. As the time
increases from seconds to minutes to days
to weeks, so does the risk of something
going wrong increases.
Some utilities have built their GIS on a less
than accurate land base. Since GIS has
been around for in excess of 20 years in
utilities, GIS pre dates GPS. So utilities that
continue to base their facility location on
antiquated grid systems will not be able to
successfully use the GIS until they correct
the land base and the facility information to
be spatially correct. There are some
advanced tools available to help in this
process but even with these tools, to
correct a GIS to an accurate land base is
highly labor intensive and time consuming.
For utilities that have not yet built a
comprehensive GIS of their infrastructure,
they should build the most accurate and
GPS compliant land base as possible.
Other utilities have built their GIS
piecemeal, with some parts of their service
territory converted to digital form while
others still in CAD or even paper form.
Many have only converted their primary
data, but not their secondary networks.
Others have converted rural overhead
areas, but have not converted their urban
networked areas. This piecemeal approach
is not effective if the GIS is to be the heart of
the smart grid. Lack of a digital model of
the electrical system (whether urban,
overhead, underground, networked, radial
or some combination) will limit the overall
effectiveness of the smart grid. Installing
smart meters in areas where the utility has
not modeled the electrical network will
inhibit much of the usefulness of the
equipment. In this case the use of the smart
meter will probably be limited to billing.
A very large problem, particularly for
countries like India, is the lack of good
customer addressing information. Even in
countries such as the United States where

virtually every premise has a physical
address, such as 125 Elm Street, utilities still
struggle with keeping this data current.
Some of these utilities don't have tight
processes to make sure that as they add a
new customer, they properly link the data
directly to their GIS. If the GIS does not have
an exact correlation of the customer
premise and the electric system, any hope
of automation and self healing will be lost.
In regions where customer addresses don't
exist, utilities will need to create some kind
of coding system that uniquely identifies a
customer location to a point in space and to
the electric distribution system. Otherwise,
it will be impossible to build a smart grid.
Once the system is in place, it is critical that
utilities have a full proof quality assurance
process that guarantees that as they add
new customers to the system, they reflect
those customers as connections to the
electrical network.

Summary
Enterprise GIS should be an integral part of
Smart Grid. Since the idea of a smart grid is
to add more monitoring and control to the
electric system, it is imperative to have a
solid model of all of the electric assets, their
condition and their relationship to one
another, to customers and to the
telecommunications systems that will drive
the smart grid. Utilities must have
processes and procedures in place to assure
accurate and timely GIS data. Otherwise,
the smart grid will be making automated
decisions based on false information.
Today, utility dispatchers make the vast
majority of switching decisions based on
their own human interpretations. Lacking
human intervention, the smart grid must
rely on a near perfect GIS model of the
electric system.
GIS is indeed a transformational
technology. In concert with the smart grid
technologies like advanced sensors, smart
meters, energy storage devices, renewable
energy systems, the GIS will certainly
contribute the transformation of the grid
from a largely passive and blind system to
an interactive and intelligence system. It
will communicate with consumers and
consumer devices and will make decisions
to help lower costs, improve equipment
utilization and reduce carbon emissions. To
do this, utilities should fully integrate their
GIS into the overall IT framework of a
utility.
Finally, the GIS is a wonderful tool to help in
the deployment of smart grid itself. Utilities
can monitor construction progress, route
crews in the most efficient way and help
with analysis for locating the best location
for repeaters, sensors and new
communication backbones.
So the smart grid can't really be smart
without GIS.
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ArcGIS 9.3 : Useful Functionalities & Handy Tips
ArcGIS Desktop
some graphics on your map. For example, use the Polygon
tool to draw two polygons.

Add useful online content to your maps.
1. In ArcMap™, open one of your existing maps or
choose File > New and choose one of the USA or
world maps.
2. Choose File > Add Data from Resource Center. This launches the
Online Layers page in the new ArcGIS Desktop Resource Center.
3. Click the layer you want to add to your map.
The layer will automatically be added to your map. Some of these layers,
such as World Imagery and World Street Map, are services from
ArcGISSM Online. Others reference services being served by government
and educational institutions.

Create new data layers from graphics you draw on your
maps.
1. Use one of the drawing tools on the ArcMap Draw toolbar to draw

2.

(Optional step) Give each polygon a name by
double-clicking each one with the Select Elements (black
pointer) tool, going to the Size and Position tab on the
Properties dialog box that appears and entering a name such as Study
Area 1 or Study Area 2 in the Element Name field.
3. Select both polygons by dragging over them with the Select Elements
tool.
4. Choose the new Convert Graphics To Features command from the
Drawing pull-down menu on the Draw toolbar. On the dialog box that
appears, check the option to delete the graphics after conversion. Click
OK, then click Yes when you are prompted to add the layer to the map.

2. In the table window that appears, right-click any field and choose
Advanced Sorting.
This dialog box lets you sort your table using up to four fields. At 9.3,
sorting is also persisted in the table window, so you can sort a table any
way you choose and it will stay that way.

Add a GeoRSS feed and text file.
1. Download and install ArcGIS Explorer from
http://resources.esri.com/arcgisexplorer.

a. Go to File > Open > Servers > GeoRSS Feed.

To add a text file

Any HTML links or formatting stored in the attribute table for the layer
will be reflected in the pop-ups that appear, enabling you to go beyond
a simple table of attributes. HTML pop-ups support XSL templates to
allow you to customize how data is displayed in the pop-up window.
These pop-ups are also supported in ArcGlobe™. Tip: To prevent
features with HTML pop-ups or hyperlinks from changing color when
you select those tools, use the setting in the Tools > Options > General
tab.

b. To open the text file storm report in
ArcGIS Explorer, do the following:
i. Go to Tools > Import File.

ArcGIS Server

ii. Browse to the downloaded text file
and click Open.

Create a Web mapping application consuming an ArcGIS Server
service.

iii. Progress through the dialog boxes and select a symbol. Click
Finish.

1. Open a Web browser and navigate to www.esri.com/javascript.

The storm events for the day you selected are now located in ArcGIS
Explorer.

4. Right-click anywhere on the new Web page (besides the actual
map) and select View Source if you are using Internet Explorer® or
View Page Source if you are using Firefox®.
5. A new window will open displaying the HTML code for this page.
6. Copy the HTML code into a text file on your computer.
7. Save the file as an HTML file and place it into a Web server. If you do
not have a Web server, try uploading this file into any free hosting
site such as http://geocities.yahoo.com. Simply navigate to your
HTML file using a Web browser.

3. Choose the desired format. Relative formats can be easier to work with than absolute formats. For example,

you'll see 1 in = 100 mi instead of 1:6,336,000. ArcGIS 9.3 adds
support for the prime (') and double prime (“) characters to indicate
inches or feet, and those characters are supported in both straight
and curly format so that text may be more easily copied and pasted
from Microsoft® Word documents and Adobe® PDF files.
Utilize Windows to Schedule and Execute Geo-processing
Workflows

4. Once you have set up your scheduled event, Windows will
automatically execute your workflow at the time and date you
scheduled. If you have scheduled your event to run during offhours, your work will be done and waiting for you the next day.
You can find more information from the ArcGIS Desktop Help at
http://webhelp.esri.com. Search for “scheduling a geoprocessing
script.”

c. C l i c k t h e U S G S E a r t h q u a k e
ShakeMaps feed and follow the dialog
box to add this feed to ArcGIS Explorer.
a. Visit www.spc.ncep.noaa.gov/
climo/reports and download a tornado,
hail, or windstorm report in CSV format.

3. Click the Show Me link at the top of the help topic. A new browser
window will open with a JavaScript™ API map.

2. To change the type of scale format, click the drop-down list next to the Scale box and choose the Customize This
List option. On the Scale Settings dialog box, click the new Scale Format tab and use the New, Edit, Delete, or Reset
buttons to create or modify the scale setting.

http://earthquake.usgs.gov/eqcenter/sh
akemap/rss.xml.

5. Click one of the features in the layer.

2. Follow the Getting Started link and select the Adding a map help
topic under the Getting Started concept in the TOC.

1. To specify a scale in relative units and have it translated into absolute scale, simply select the text in the Scale box
in the ArcMap Standard toolbar and type the desired scale. The display will zoom to this scale. You can use unit
abbreviations such as “in” for inch or “m” for meter.

To add a GeoRSS feed
b. Add the following feed into the Server Content:

4. Click the new HTML Pop-up tool on the Tools toolbar.

With ArcGIS 9.3, not only can you enter relative map scales (e.g., 1 inch = 100 miles) and have ArcMap™ translate
them to absolute scales (1:6,336,000), but you can also report scales as relative or absolute using predefined
formats in ArcMap or custom formats you define.

2. Launch the ArcGIS Explorer application.

1. In ArcMap, open one of your existing maps or choose File > New
and choose one of the USA or world maps.
3. Check the box that says Show content for this layer using the HTML
Pop-up tool, and click OK.
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ArcGIS Explorer

Access attributes via new HTML pop-ups.

2. Double-click any layer and go to the new HTML Pop-up tab.

The Layer Properties and Open Attribute Table options are located at the bottom of the context menu.
Choose the Map Scale Format

You'll see a new polygon layer appear in your map containing two
features. If you identify these features, turn labeling on, or open the
attribute table for the layer, you'll see that the names you specified in
step 2 are in the Name field for the polygons

Sort tables on multiple fields.
1. In your map, right-click any feature layer in the table of contents
and choose Open Attribute Table.

the name of the feature.
3. In the context menu, choose Layer Properties to open the Layer Properties dialog box for that layer or choose the Open Attribute Table to open the
attribute table for that layer.

Handy Tips
Access Layer Properties and Attributes with Identify Tool
If your map contains many
layers and you want to change
a layer's properties or view its
attribute table without
hunting for it in the Table of
Contents, use the Identify tool.
1. Choose the Identify tool
from the Standard toolbar.
Click a feature in the map.
2. In the left pane of the
Identify window, right-click

Building geoprocessing models
is a fantastic way to document
and preserve your GIS
workflows. A common
workflow or task may consume
your computer for a significant
portion of the day or tie up
bandwidth in your office.
Creating a model and running it
as a scheduled event during
nonworking hours can not only
make your office a happier place
but also increase your efficiency.
Let's take a look at the steps
involved in doing this.
1. Create a geoprocessing model using ArcGIS Desktop.
2. Once your model is created, you will need to export the model
to a scripting language such as Python®. You can do so by
selecting Model > Export > To Script as shown in the illustration
below.
3. Once your model is exported to script, you will need to schedule
your workflow to execute with Windows® Scheduler. The
scheduler is part of the Windows operating system and can be
found at Start > Programs > Accessories > System Tools >
Scheduled Tasks.

Share, Add, or Look at Data Quickly with Layer Files
Open Layer files from Windows Explorer, Microsoft Outlook®,
Windows Desktop, or a link in a Web page. After double-clicking a
layer file in Windows Explorer, if ArcMap is not currently open, it will
be invoked. If ArcMap is open, the layer will be added to the current
map. If the layer requires ArcGlobe™, ArcGlobe will open or will add
the layer to the session.
Microsoft applications, such as Windows Explorer, now recognize
ArcGIS layer files. Launch ArcMap or ArcGlobe by double-clicking a
layer file or dragging a layer file referencing Web content in an e-mail
to an open map document.
If the layer file references Web content, such as a layer from ArcGISSM
Online, you can e-mail the layer file, and the recipient can immediately
drag layer files from Microsoft Outlook to ArcMap or ArcGlobe. Also,
double-clicking a link to a layer file in a Web page will launch it. This
makes the ArcGIS Online layers available at the ArcGIS Resource
Center (resources.esri.com/arcgisdesktop) more convenient to use.
Restarting Services with One Click in ArcGIS Server
Stopping and starting services in ArcGIS Server Manager can now be
accomplished in one step using the new Restart button on the
Services tab. When using the Microsoft .NET Framework, the toolbar
Start, Stop, and Restart buttons are also available for each service via a
context menu.
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Interview

Prasunn Dutta
Mr. Dutta, hearty congratulations to you and your
team on winning the extremely prestigious ESRI
SAG award this year. Our users would be very
keen to learn of the unique things adopted by
RINFRA in implementing the Enterprise-wide GIS.
Thank you for your appreciation. For a plan to work
successfully, two things are required, sound vision and
great leadership. It is due to this passionate approach to
Reliance ADA Group which combines the two
dimensions that we have created a world class
Geographic Information system (GIS) technology for
our company.
Please share with our users some of the best
practices that evolved during the implementation of the project.
Best practices are normally dependent on business imperatives and context.
For example if , in any process, speed is a crucial factor for business then the
best practice is to avoid any unproductive steps, if control is the key, best
practices are those which have in built checks and balances to ensure
adherence to norms.
Considering our nature of business, the application of GIS to the entire
distribution business of Reliance Infrastructure was a challenging task
particularly because the distribution of electricity involves a large geographical
spread. Our assets are spread out, our work sites are scattered, our offices are
dispersed, our customers are everywhere and so are our employees. This
dispersed nature of operation brings in its wake several complexities. Due to
such a wide spread nature of business, the work is influenced by conditions at
the site. The approach to the work, tools & tackles required, quantum of
material required, volume of work, skills required, etc. all can be and are often
different for various work sites.
The physical location and the concomitant complexities are major
determinants of how the work will be carried out. For instance, if you need
to extend the cable to accommodate a new connection, you need to know
the nearest junction from where a connection can be extended, whether
adequate capacity exists, what is the length of the cable, what are the
physical obstructions in pulling the cable, how do we extend the cable to its
destination, etc. A moment's reflection will reveal that the physical
conditions will influence the choice of workmen including their numbers,
material requirement tools & tackles etc.

For the future, the plan is two-fold. While initial steps
towards 'GIS as work space' have been taken, the entire
application will grow richer with usage and continuous
improvement. While earlier adoption was slow now the
pace has grown and changes are being sought by end
users. In fact, as we speak, several interesting changes are
being made to existing processes to further use the
capabilities of the GIS. I reckon this will continue well into
2009 as the earlier changes get institutionalized.
The other part of the plan relates to new businesses. As
you are aware RInfra is on the threshold of a major
expansion. We are entering several businesses and most of these do have a
strong spatial component in their functioning. Extending the application
currently implemented further we intend to carry this to our new
businesses.
Please explain your exciting and unique concept of “GIS as
workspace”.
Because of the dispersed nature of our business, we found that GIS ideally
addresses the task of modeling 'our' reality with its related complexities.
The reality experienced by our field staff is best represented through the
GIS. Hence as they work in field they should be able to work on the GIS
based systems. In other words the GIS is where they carry out their day to
day work or 'GIS' is now their 'Work Space'. This is, in essence, the concept
of GIS as work space, which we have attempted to initiate at RInfra.
To realize the concept fully calls for several concrete steps. The GIS usage
needs to be skillfully interwoven into the work processes so that the full
utilization of the software is achieved. Secondly the update process is to
be made an integral part of the work procedure and a necessary step for the
subsequent processes. Interfacing with other application such as an ERP or
a document management system is essential to address end to end
processes. Last and probably the most difficult critical step is managing the
consequent changes in work procedures. If we are able to do all of the
above and it becomes easier for the person to use the software in this
manner the concept of 'GIS as work space' would be achieved.
Based on your experience, what would you like to suggest the CIOs
of other Utility companies in India?

GIS is probably the only application that has the potential to represent the
reality along with complexities encountered in the conduct of such work
which makes it an ideal I.T. system for the distribution business.

I would urge CIO's of utilities to go in for a GIS based working, at least for
the field personnel. While this would call for several fundamental changes
in working, gains there from will be worth the efforts made.

The 'best practices' in this case therefore are those which avail of GIS in
planning & execution of field work. Some processes which have been
augmented by GIS include locating faults in the network, network planning
including extension of the network, operations & control of the network
deriving from an integration of our SCADA & GIS, streetlight planning and
maintenance.

If you were to list 5 key reasons “why GIS is a must for Utilities”,
what would those be?

What was RInfra's original vision of implementing GIS? And, now, as
the System is already in place, how do you see your vision
materializing?
The original vision of the GIS implementation was at best nebulous. I knew that
the software was not merely colorful depiction of a map. I also knew that
ultimately a significant set of transactions should be GIS based. But I did not, at
that stage, have enough clarity to articulate how this would happen or what kind
of integration (with other existing systems) this would call for. However, it was the
far sightedness of our top management that sanctioned the resources for this
project despite the fuzzy picture.
We have come a long way from the initial concept. Over time, the concept
has concretized and we have taken steps to utilize the GIS for several field
transactions. The software has been interwoven into these transactions so
as to ensure full utilization of the same. Significant hurdles have been
overcome and the direction clearly set. Interest has been aroused amongst
end users, who are now asking for enhancements. Usage is increasing and
we have now entered a self sustaining stage. So, yes we have achieved our
original vision.
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Having already accomplished so much, what is the
GIS roadmap of RInfra from hereafter?

GIS involves synchronization of different technology in to one system. It
combines computer hardware, software and data to create a tool for
capturing, managing, analyzing and displaying all forms of geographic
information. Virtually any information can be linked to a geographic
location, allowing users to see that information as part of a complete
picture to be analyzed and applied to a problem of issue. With GIS, people
can see first hand how things change, view and manage information about
locations; analyze spatial relationships and visualize processes. It is all about
making smarter decisions.

Geoinformatics in TERI University
TERI University (www.teriuniversity.ac.in) has been set up as an
institution of higher learning and is recognized by the UGC as a
deemed university. Its academic programmes have been have been
structured around the research experience and skill sets gained in
The Energy and Resources Institute (TERI) (www.teriin.org) over the
last three decades. The university offers MSc programmes
(Environmental Studies, Natural Resources Management, Water
Resources Management, and Plant Biotechnology), MBA
(Infrasturcutre), MA (Public Policy and Sustainable Development)
and other short programmes.
The University has been offering two courses namely
Principles of Geoinformatics (Core Course) and
Geoinformatics for Natural Resources Management
(Elective Course) to its Masters' students. The courses
are designed to serve as a foundation to understand
the fundaments of RS/GIS/GPS and their applications
in various disciplines and to develop skills of the students
in field of RS/GIS/GPS respectively.

We have a well equipped Remote Sensing and GIS laboratory with
ESRI products. At present ArcGIS 9 and Erdas Imagine 8.7 are being
used for the education and research purpose. ESRI India, New Delhi
has been of great help for regular updation and technical support
towards this. The university also plans to expand it remote sensing
and GIS facility in this coming session. Apart from the mainstream
education activities, University is also engaged in funded research
activities and consultancy. In the field of Geoinformatics, TERI
University is participating in the National Resources Repository
programme of NRS/DOS, Biodiversity characterization at
landscape ecology programme of DOS-DBT and many
other research activities of TERI. The students'
projects have emphasized on habitat
characterization, landscape analysis, protected
area management, development of web enabled
information system.
The last date for application for the academic year
2008-09 is April 14, 2008.

The university has announced a Master's in Geoinformatics and a
Post Graduate Diploma in Geoinformatics in the academic session
commencing July 2008. The programme structure and course
contents have been prepared after a thorough needs assessment,
survey for placement options and evaluation by experts in the field.
The programme covers RS/GIS/GPS and geo-spatial modeling
techniques with a wide range of application in areas such as
environmental modeling, landscape ecology, integrated impact
assessment, watershed management, climate change etc.
Competing with the present requirements in this field, the
programme has introduced course work on project management,
law and policy.

For more information, visit www.teriuniversity.ac.in
Contact: The Registrar, TERI University, Habitat Place, Lodhi Road,
New Delhi - 03
Tel. +91-11-2468 2100/2111; Fax +91-11-2468 2144/2145 E-mail
registrar@teri.res.in

Group and individual projects using diverse spatial-temporal
datasets will be used to demonstrate specifics in the environmental
and social sciences. Pedagogy will include formal classroom
teaching, workshops, hands-on practice, field excursions etc.
Interactive sessions will be arranged with players and stakeholders
in data management and plan execution from the government,
private sector, entrepreneurs and NGOs.

Tutorials (9%)

MSc

Also it is very useful tool because;
i)

It is the only I.T system which truly reflects the reality faced and
encapsulates related complexities therein.

ii) It renders several resources hungry activities easier resulting in higher
productivity.
iii) Time required for execution of a task is much less while supporting
improved customer service
iv) Visibility on an on-line, real time basis of the electrical network reduces
time to get on board a new entrant.

PGDip

Tutorials (11%)
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v) Realistic display of relevant parameters helps plan and analyse work in
an efficient manner
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ArcGIS JavaScript API
The ArcGIS JavaScript™ API is a browser based API for developing high performance, easy to use mapping applications.
The API allows you to easily embed maps in your Web pages.

=

The JavaScript™ API is hosted by ESRI on ArcGIS Online and is available for free use.
The ArcGIS JavaScript™ API is a browser based API for developing
high performance, easy to use mapping applications. The API
allows you to easily embed maps in your Web pages.

=

The JavaScript™ API is hosted by ESRI on ArcGIS Online and is
available for free use.

Querying

=

Finding addresses

=

Finding attributes

=

Identifying features

=

Geoprocessing

=

Why JavaScript?
=

JavaScript is a language you can use to increase the interactivity of
your web pages. JavaScript runs inside your browser immediately
when something happens on the page, such as when someone
clicks a button or pans a map. You don't have to wait for something
to happen on the server, and the whole page does not blink or
refresh. For this reason, JavaScript is an excellent choice for
embedding maps in your applications.
We don't have to download or install anything in order to program
with JavaScript. All web browsers know how to interpret it. In many
cases, the JavaScript code can be embedded directly into the HTML
page.
JavaScript is accessible to beginning programmers. Even if you
haven't programmed with JavaScript before, you can learn how to
build JavaScript applications by cutting and pasting example code
into your HTML pages. In many cases, the example may be just what
you need with only minor adjustments.

What can you do with the ArcGIS JavaScript API?
We can use the ArcGIS JavaScript API to bring maps and tasks from
ArcGIS Server into your web applications. For example, we can:
=

Display an interactive map of our own data

=

Execute a GIS model on the server and display the results

=

Display our data on an ArcGIS Online base map

=

Search for addresses and display the results

Remember that we don't need to have ArcGIS Server installed on
your machine in order to program with the ArcGIS JavaScript API.
We just need to have an ArcGIS Server available that you can access
through a URL. ESRI has provided several sample servers that you
can use as you practice writing JavaScript applications. The samples
in this help system use the sample servers.

Access to Dojo and other libraries - The ArcGIS JavaScript API is
built on the Dojo JavaScript Toolkit, providing you access to
dijits (Dojo widgets) and other JavaScript tools. You can also
integrate other libraries in your applications, such as the Google
Chart API.

Other JavaScript APIs
ESRI provides two other ways to embed ArcGIS Server functionality
in your web pages with JavaScript:
=

=

The ArcGIS JavaScript Extension for the Google Maps API gives
you a way to work with your GIS services in the framework of
Google Maps and other Google APIs.
The ArcGIS JavaScript Extension for Virtual Earth lets you access
your GIS resources from a Microsoft Virtual Earth control in 2D
or 3D.

What's new in Version 1.2
The following are new features in the ArcGIS JavaScript API version
1.2:

What does the ArcGIS JavaScript API include?
The ArcGIS JavaScript API provides the following resources for you
to use in your web applications
=

28

Search for features or attributes in our GIS data and display the
results

We can use the ArcGIS JavaScript API to access information from
several different servers in one application. One common reason
you might do this is to display some of our own information on top
of a base map from ArcGIS Online or from other web sources. In
another scenario, we might use a model on one server and display
the results on a map from a different server. This combination of
information from multiple web sources is sometimes called a
"mashup".

Tasks - The API includes classes and methods for common GIS
tasks:

=

ArcGIS JavaScript API Overview
The ArcGIS JavaScript API is a lightweight way to embed your GIS
maps and tasks in Web applications. It's free to use and deploy
applications built with this API. All you need is an ArcGIS Server
available whose maps and tools you can use in your application.

Graphics - You can enhance your web applications by allowing
users to draw graphics or by providing informational popup
windows when the user clicks or hovers the mouse over a
graphics feature on the map.

Maps - The API supports display of both dynamic and cached
(tiled) map services from ArcGIS Server. With the ArcGIS
JavaScript API, you can display maps in any projection.

Support for Image Services
We can add ArcGIS Server Image Services to the map using
ArcGISImageServiceLayer. Image services represent file-based
raster datasets or raster collections published with the ArcGIS
Server Image extension. We can control the image type,
compression type for JPG, image bands, and interpolation type.

Support for Dojo 1.2.
When you reference the ArcGIS JavaScript API in your code, you
also get a reference to version 1.2 of the Dojo Toolkit. See the Dojo
1.2 Release Notes for migration information and a full list of
improvements.

More flexibility with cached and dynamic layers
We can now define which tile levels of a cached service are exposed
in the map. For example, we may want to use ArcGIS Online data
for small scales only, then switch to our own cached data at large
scales. Or we may want to make a cached service available at large
scales only in order to focus the map on a certain geographic area.
We can also force dynamic maps to conform to the scale levels in a
tiling scheme. This allows us to show a cached map at small scales,
then easily switch to a dynamic map at large scales.

Refreshable map layers
Map service layers have a refresh() method. This is useful if backend editors are modifying the data and you want to ensure the end
user of the application sees the most recent data from the server.

Improved graphics performance
The performance of the graphics layer is improved when adding a
large number of graphics to the map.

Projection of dynamic map services on the fly
Dynamic map services can be projected on the fly to match the
spatial reference you set for the map. Previously, the spatial
reference was defined by the base layer. Now the map can be
defined using any spatial reference. Valid only with dynamic map
layers.

New methods for the geometry service
GeometryService has new methods that allow for creating points in
polygons for labeling purposes, and determining spatial relations
of geometries. These geometries do not have to come from a map
service; they can be geometries returned from a task or a query to a
non-ArcGIS Web service.
For further details, please refer http://resources.esri.com/
arcgisserver/index.cfm?fa=JSAPIs
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centers the map; the extent on the overview map updates
automatically.

Enable Seamless Panning for Layers in Web Mapping
Applications

For those working in Visual Studio, you can change this setting
using the StaticMode property on the Overview Map control.

ArcGIS Mobile

In ArcGIS Server Manager, for each layer added to your Web
application, you can set whether seamless panning will be
enabled. Seamless panning is the mode that allows you to see
the map image as you are panning. When seamless panning is
disabled, you can expect a faster map redraw. You may want to
enable seamless panning for a cached map layer but leave it
disabled for layers that are not cached.

ArcGIS Server for the Microsoft .Net Framework
Web Mapping Application

ArcGIS Mobile Application now supports Windows Mobile
Smartphone's

Table of Contents Performance Improvements

At the 9.3 release, the ArcGIS Mobile application supported
Windows Mobile 5.0 Pocket PC/Windows Mobile 6.0 and 6.1
Windows Mobile Professional (touch screen) devices. At the
9.3 SP1 release, the application is now fully functional on the
Windows Mobile 5.0 Smartphone/Windows Mobile 6.0 and
6.1 Windows Mobile Standard (non-touch screen) devices. All
menu items have full keyboard access, list items are presented
as full screen menus, and map navigation is optimized for
rocker and keypad use.

Significant improvements were made to the table of contents
control to improve memory usage and overall performance.

Java Web ADF
9.3 Service Pack 1 for the WebADF for the Java™ platform
contains numerous quality and performance improvements.
The Java Server Faces (JSF) libraries have been upgraded from
v1.1_01 to v1.1_02. This JSF version improves the ability of Web
applications to handle concurrent Asynchronous JavaScript™
And XML (AJAX) requests.
The WebContext and GroupThreadPool classes now use the
Java SE 5 Concurrent API and maintain a single thread pool for
the entire Web application. This helps reduce the memory
footprint of Web applications. Applications are also more
scalable because the thread pool grows and shrinks
automatically as required when load increases and decreases.

You can find the Seamless Panning checkbox in the Layer
Properties dialog box. Open the Layer Properties dialog box by
clicking the map service layer in the Add Layers tab of ArcGIS
Server Manager.

Web Geometry objects fully support two-step
geotransformations and the overall Geometry package has
been optimized for better performance while reprojecting
geometries.

For those working in Visual Studio®, the seamless panning
option is set from the MapResourceItem Collection Editor
dialog box, in the Display Setting Editor, by setting the Dynamic
Tiling property.

The WebMap allows zooming beyond the smallest and largest
scales of cached services in the application if there is also at least
one dynamic service. Users can take full advantage of dynamic
services because they are no longer restricted to only the scales
of cached base maps in their applications. This functionality can
be enabled by setting the 'zoomBeyondCache' property of the
WebMap object in faces-config.xml.

Set Static or Interactive Mode for Overview Map in
Web Applications
In ArcGIS Server Manager you can set either a static or
interactive mode for the overview map in your Web application.
By default, the mode is static, as this results in the best
performance.
If your application
requires that the
overview map be
closely in sync with
the map, you can
choose the
interactive mode.
With this setting,
the overview map
is set to update
when the Web
application user
zooms in or re-
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Support has been extended for FireFox™ 3 browsers and 64bit Java Virtual Machines (JVM); please see the System
Requirements for further details.

ArcGIS Server Manager for the Microsoft .Net
Framework

Blob capture on Windows Mobile devices
At the 9.3 SP1 release we have fixed a problem you may
encounter when trying to capture and store pictures, voice or
other information directly into a blob field.

Full support for PostGres SQL
At the 9.3 final release, ArcGIS Mobile did not support the
editing of GIS data that was stored inside of a PostGres SQL
database. This is now fully supported with service pack 1.

ArcGIS Extensions
Spatial Analyst extension: Now supports ObjectID field as a
valid type for feature class inputs
This enhancement applies to tools that take a feature class as
input for which a field can be specified. These tools include
Feature to Raster conversion, Distance tools (Cost Allocation,
Cost Path, Euclidean Allocation, and Path Distance Allocation),
Hydrology tools with a pour point field (Snap Pour Point and
Watershed), and Zonal tools (Tabulate Area, Zonal Geometry,
and Zonal Statistics).
During analysis these tools internally convert the input feature
class to a raster and use the field to define the values for the
raster. Previously, only fields of type integer or string were
accepted. We now support ObjectID as a valid field type for the
input field parameter.

The Scale Bar has been improved to be visible over black
backgrounds.

When specifying an input feature class, the field parameter will
default to the first valid field of the input feature class (i.e., 'ID'
or user-specified field). If no valid fields exist, it will default to
the ObjectID field.
For details on bug fixes and quality improvements which was
the main purpose of service packs, and for a full list of the
quality issues that have been addressed in the ArcGIS® 9.3
SP1, please refer http://gisupdates.esri.com/93sp1a/ArcGIS93sp1-issues.htm

ArcFM Server:

Flexible Web Environment for
ArcFM Solution
“Telvent Miner & Miner continues to build on its powerful
ArcFM Solution suite. This latest release adds an out-of-thebox web application and interfaces to operational systems
such as SCADA and DMS. This new release includes new tools
and improved performance and scalability,” says Rich Ruh,
TM&M's Director of Product Development.
Today's utility information technology (IT) environment
requires solutions that can support multi-disciplinary requests
and be available in distributed locations. ArcFM Server provides
the key components for addressing these IT requirements for
electric, gas, and water/wastewater utilities in editing,
modeling, maintaining, and managing facility information
ArcFM Server supplements the comprehensive ArcGIS Server
toolkit, and includes a number of ArcFM-specific components
that support editing and business rule enforcement, model
names, and ArcFM properties. ArcFM Server is a valuable
technology for organisations that need to implement
transaction-based systems and ArcFM functions that are
embedded into server-centric architectures. With a single
licence, ArcFM Server may be deployed to a large number of
users.
ArcFM Server now includes an out-of-the-box web browser
application known as ArcFM Viewer for ArcGIS Server. This
application provides the ability to trace and identify features
and view ArcFM Attributes. ArcFM Server is built on ESRI's Web
ADF and integrates directly with ArcGIS Server Manager. The
customization API allows developers to extend the existing
functionality within custom web applications. ArcFM Server
web services can be consumed by third party applications and
provide a key component for supporting SOA business
solutions

Application Examples
=

=

=

=

Within an outage management call entry browser-based
application - e.g. upon selection of a customer address,
you could zoom to the extent of the service location for the
purpose of displaying incidents within the vicinity of the
service location
Design status browser-based application - e.g. when given
a work request and design id, you could view the design
Extending marketing applications such as using a spatial
query to determine whether existing facilities are within a
predefined distance
Given a device, return a
list of the upstream
protective devices

Simple editing applications
(e.g. managing pole
attachments) that do not
need a full-fledged editing
environment
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Representational
State transfer (REST) Application
Programming Interface (API)

Mashups as Enterprise Applications:

REpresentational State Transfer (REST) is a style of software
architecture for distributed hypermedia systems such as the
World Wide Web. It is an inherently intuitive environment for
creating map images with ArcWeb Services. The REST API
permits you make requests to ArcWeb Services via a URL.

A new trend in Web application development “Mashup” is a
lightweight web application that combines data from more
than one source into an integrated and new, useful experience.
Initially, Mashups laid focus on mixing different data sources
together, offering a quick and simple way to create situational
business applications. In Mashup, features Widgets and feeds
that are mashed together often come from independent
sources and do not change when mashed. This is built on a
web-oriented architecture (REST, HTTP) and leveraging
lightweight, simple integration techniques.

The new for real-time information on forest resources is
growing at both national and international level. Demands for
new types of information are now frequently being raised
(regarding e.g. biological diversity, non-wood forest products,
forest quality). Globally there is an increasing demand for more
and new types of information about the forest resources.
Forests are being impacted by both natural and anthropogenic
factors. These lead to the reduction or loss of multiple benefits
of forests.

ArcGIS Server 9.3 includes a series of JavaScript APIs for
mashup-style development. These new APIs allow JavaScript
developers to easily embed ArcGIS Server Web mapping
applications into any Web site.

The Directorate of Forest, Government of West Bengal is fully
aware of the importance of Forest Information System and has
planned to develop a portal, West Bengal Forest Information
System (WBFIS), to monitor and distribute the information of
Forest and Forestry activities of the West Bengal State
efficiently and effectively for all the forest officers.

REST API:

Use REST to create maps in raster and vector formats; add
acetate lines, points, and polygons; add graticules, legends,
north arrows, and scale bars; and take advantage of auto
projections and best data source. Scalable Vector Graphics
(SVG) Map Viewer is an interactive vector-mapping sample that
uses REST mapping.
ArcWeb Services offers a fully customizable SVG Map Viewer
with downloadable source code, as well as more powerful
features for the REST API. The latest version of the REST API now
provides built-in data layer switching as well as the ability to
include tiled satellite imagery where, developers don't have to
write the code from scratch.

A New Concept in Web
Application Programming

Introduction

Where do Mashups Make Sense?
=
=
=
=
=

Ideal for tactical and opportunistic applications
Implementation speed and flexibility are paramount
Construction is a LOB assembly
Addresses specific business product
Often combines external and internal content

ARC GIS Server 9.3 REST API
Resources and Operations:
=

Map Services: Export, Find, Identify

=

Map Service layers: Query

=

=
=

The Internet is in a phase of spectacular expansion and has
found its way to most of us in some form, whether we like it or
not. It opens completely new possibilities of spreading and
accessing information in large quantities. Exchange of
information and dialogue can become very efficient through
networking with cooperating partners. However, we have
certainly only seen the beginning of this and need yet learn
using this tool wisely.

Geo Processing: Execute, Submit job
Geometry Service: Project, Simplify, Buffer, Length and
Area, Relation

Image Services: Export
Resources and Operations result can be returned as:
HTML (Services Explorer - Default)

=

IMAGE (Direct Streamed Image)

=

KML (Google Earth, Google Maps and Virtual Earth)
JavaScript Object Notation

New caching tools allow users to optimize data resources for highperformance Web services, making application tasks run fast and
efficiently

Key Benefits:
=

=

=

=
=

=
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The state of West Bengal extends from Himalayas in the north
to the Bay of Bengal in the South. The geographical area of the
state is 88752 sq km. five states and three countries surround
West Bengal. The recorded Forest land in the state is 11879 sq
km of which 7054 sq km is reserved forest, 3772 sq km is
protected forest and 1053 sq km is unclassified forest, thus
consisting 13.38% of the geographical area of the state.
However, through sustained effort of Joint Forest
Management, through people's participation, the state has
increased its forest area to 15.68% as in 2006.

The application provides key web publishing capabilities such as
map display, legend creation and layer management. The
working plan section deals with the classification of forest covers
last from decades and help in preparing stock maps. Also it gives
information about various developmental and plantation
schemes implemented at particular circles and divisions..

Conclusion
The WBFIS application had proved to be advantageous for
efficient and effective monitoring in the following ways:
=

=

=

=

=

=

Technology

Geocode Service: Find address candidates, Reverse
Geocode

=

WBFIS

Empower knowledge workers and web developers to
rapidly create new web applications, unleashing
productivity and reducing IT backlog
Speed development and reduce costs through lightweight
integration, reuse, and sharing
Quickly uncover new business insights by easily assembling
information from multiple sources on the glass
Better align IT and business through rapid prototyping
Make SOA more business-relevant and visible, increasing
reuse of services and widgets.
Foster innovation, while applying the appropriate levels of
IT control

The introduction of Geographic Information Systems (GIS) in
forestry applications opens new possibilities of analyzing data.
Analysis of multi-source information is a particular strength.
This is of importance at all levels from local to global.
ArcIMS has a multiservice architecture designed to support
access to ArcIMS and ArcMap image services, as well as
services from ArcGIS Server, ArcWeb Services, and Web
mapping services. This means that maps from multiple services
can be integrated into a single Web application. The Web
application's GIS functionality can be easily configured as well.

Approach
After identifying the problem and with the advent of
technology, the solution was to develop a Web-based GIS
West Bengal Forest Information System application for the
forest officers of West Bengal state. The application was an
Internet based system built to serve the users spread over the
Internet. The server-side hosts ArcIMS and Web Server for
serving spatial data stored in Shape files and attribute data
stored in MS-Access database in the backend.

=

=

=

=

The application will cut down the overhead time involved in
updating the data locally at all the forest departments in West
Bengal.
The application will adds flexibility to access the necessary
data at any time and at any place.
Forest coverage areas were clearly distinguishable and can be
downloaded up to minor level i.e., Block / Compartment or
Mouza / JLno. area.
District-wise details for all the layers can be rendered /
displayed.
Buffer Zone can be drawn around a feature of interest which
gives various solutions like fire-prone zone, restricted areas
etc.
The Stock maps for division level can be viewed and the
classification of forest covers can be known.
The Fire-Alerts between a specific duration can be seen, and
the necessary planning and observation can be done.
Plantation Monitoring Reports plays a significant role in
assessing the future plantations and estimating of
productivity.
All the Protected areas and Rest Houses connecting through
Rail and Road network can be identified.
The Query-builder provided facilitates to build a valid syntax
on all the layer
information to
draw conclusions
using resultant
attributes.

The web portal of
West Bengal Forest
Information System
for the Forest officers
spread over the West
Bengal state can
access the website
through their login
credentials and take
appropriate actions
as and when needed.
The screen-shots of
website are as
follows.
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Case Study
“Favourable potential zone map using
Remote sensing and GIS”for all the 385
blocks of Tamilnadu.
TWAD Board is shouldering the responsibility of providing
potable and adequate drinking water facility to all the settlement
of the state except Chennai Corporation. Scientific source
finding is the practice is followed in TWAD with a well planned
and well-equipped Hydro geological unit provided with remotely
sensed data products to advanced scientific instruments to
narrow down the failure rate in source creation. Over the years a
voluminous database have been pooled from the state allover
with respect to population to groundwater potential. All the
technological advancements have been evaluated and updated
for better performance of the of drinking water delivery.
An R&D and GIS cell and a remote sensing unit is functioning in
Head office TWAD board with personals having enough
expertise. Data products such as survey of India Toposheets,
Aerial photographs and satellite imagery both hard copy and
digital copy for the whole state is available. ERDAS imagine
professional and Arc Gis software used for Raster and Vector
analysis are available with the GIS cell. Enough number of
advanced computers along with its peripherals is available with
this unit. Data on census hydrological and hydro geological
informations are available as softcopy, which could be used as
such with minimum formatting.
The GIS cell has brought out a “Digital water resource Atlas”
which accommodates at least 14 layers based on
Administration, Geology, Hydrogeology, Geochemistry and
other hydrological details. The basic spatial unit is
Panchayat/Revenue village and the information unit is the
habitation with the display unit of Panchayat union.
The state land use board (SLUB) of planning commission
Tamilnadu has accorded approval for the Preparation of
“Favourable potential zone map using remote sensing and GIS”
for all the 385 blocks of Tamilnadu.

The present project aimed
=

=

=
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To update ground water potential zonation map for
individual blocks of the state.
To update maps showing ground water quality with respect
to potability and suitability
To update maps showing geomorphologic units and its use
based on its natural resource potential.

Case Study
villages have labeled and the settlements of the villages have
been located. The whole exercise has been accomplished using
GIS.

4 Action plan Map

2. Water resource map:
Hona'ble Minister for Local administration Mr.Mu.Ka.Stalin releases
the report on 19.1.2008 and Prof.Naganathan. Vice Chairman State
Planning commission receives it. Mr.K.Deenabandhu .IAS. Principal
secretary MAWS, Govt of Tamilnadu, Mrs.Girija Vaidyanathan. IAS
.Member secretary, Planning commission, Mr.Swaransingh.IAS.
Managing Director, TWAD and Mr.Satyabrata sahoo. IAS, District
Collector, Thiruvannamalai are also in the picture.

This map indicates the potable ground water potential in the
block where in the settlements of the villages have been marked

This is an integrated out put based on the thematic maps like
Administrative setup, drainage, lineament, geomorphology,
water quality and ground water potential. This maps indicates
the probable location for creating new water sources and the
location for constructing recharge structures with specific type
of structures.

so that decision can be made where a source could be identified
with respect to quality and potential and demand. Themes
prepared based on potential and water quality for the district
water resources Atlas has been utilized. Categorization of
potential zones representing < 50lpm, 50-100 lpm, 100-200lpm

=

To generate action plan map for individual blocks of the state
to create new drinking water source and conservation facility
for sustainable drinking water development.

and >200lpm has been prepared and the quality map showing
potable and non-potable zones ha been overlaid on the
potential Map.

Accordingly a Draft copy maps for KARUR District has been
completed with the following themes for individual blocks and
presented before the officials of PWD,IRS and other line
departments of the state A completed block theme for
Aravakurichi in karur distrcit was presented and the suggestion
offered at the meeting for refining the themes have been
incorporated in the block themes of other districts.
On 19.1.2008 the Honb'le minister for Local administration in
the presence of officials of SPC and MAWS released the CD
containing the completed themes for the Districts and the
Honb'le Vice Chairman State planning commission received the
Report and the Member secretary received the CD containing
the details for Thiruvannamalai District in the presence of the
District Collector.
The CD released contain the following maps as Jpeg and as wells
as in GIS format for individual blocks of the Districts.

1.Administartive setup:

3.Geomorpholgy and lineament:
IRS digital data has been processed using image-processing
(Remote sensing) software. Different geomorphic units have
been classified based on interpretation criteria with respect to

Prepared using survey and land records Taluk maps and Block

groundwater potential. Filtered linear fracture system

maps showing Panchayat village /Revenue village boundary with

considered being zones for exploring groundwater and for

labels. Urban areas have been differently identified. Different

storing the surface runoff during monsoon to make the

types of roads have been suitably displayed. The names of the

groundwater enriched for future use.

A training program has been organized at Chennai to the district
officials where in they have been exposed to the two type of
delivery made to the districts such as the products in JPEG format
and GIS format. It was explained to them that the jpeg format
could be used by any one by taking a print out (whole or part ) so
as to implement water related activities such as new source
creation and construction of Recharge structures. For using the
Jpeg format the district unit doesn't require complete computer
setup with GIS software. Printing can be out sources and the
portion of the villages could be printed out and made available at
the village level itself so as to use it whenever necessary.
The themes with GIS format could be used at the district level
provided if there is a full-fledged GIS setup with computers and
software. The procedure for Editing, updating and generating
new themes for the use of line departments of the district have
been imparted during the training program. The entire
operations on the usage of the themes generated made simple
and easy to use hands on tutorials were given in the training and
the trainees drawn from the districts interacted during the
training and afterwards also.
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Event Coverage

enhancements in the recently released ArcGIS 9.3 were showcased
in contexts of developing GIS integration, applications and
technological solutions, and infrastructure that supports
communal exchange. To do so, ESRI presenters demonstrated
software advancements.

2008 ESRI
International
User Conference
(ESRI UC)
“Amazing" was a popular descriptor uttered by wide-eyed
attendees of the ESRI User Conference this year. The 28th
ESRI International User Conference (ESRI UC) was held on 4
-8 August 2008 at San Diego Convention Centre,
California. The user conference was attended by 14,000
GIS professionals from 110 countries belonging to various
industries across the globe. The largest congregation of GIS
witnessed the presence of the GIS professionals from
various streams sharing knowledge, experience and
technical know how in GIS, updating themselves with latest
technology developments and sharing their experience.
The works of GIS users around the world were highlighted
by ESRI President Jack Dangermond. Illustrating the
conference theme “GIS: Geography in Action,” Jack
Dangermond talked about the importance of GIS as part of
the solution to the challenge of living in a sustainable
world.The company has a clear vision of developing
strategies, software, and support to look at our world to
help make informed decisions.

Looking Ahead
During the Plenary session ESRI President Jack Dangermond
envisioned his thoughts for the future of GIS that
geography and humankind have come far ahead building a
strong foundation with numerous and variety of GIS
applications to cater in every day to day life.
"I believe that GIS work is driving change and is creating a
digital foundation by abstracting data, models, and
workflows," said Dangermond. "Our thinking is becoming
spatially integrated, changing how we reason, defining
patterns of our actions, evolving collaborative structures.
Moreover, GIS is changing our work to adopt a sciencebased approach. We are introducing systems for
measuring, accounting, and analyzing geography, then
visualizing it to make decisions. GIS is helping people plan
for a more sustainable world. GIS is raising awareness."
Dangermond described how GIS is enacting change within
IT user communities. "Today's GIS implementations follow
three patterns, the Desktop for creating and editing data,
the Sever for sharing information to a wider audience, and
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ArcGIS Desktop Enhancements
ArcGIS Desktop improvements were described including
functionality that simplified users' tasks from keyboard shortcuts,
to reverse geocoding, to converting graphics to features.
Capabilities for sharing by connecting the desktop project to the
GeoWeb showed the ease of consuming ArcGIS Online content,
exporting KML, and using GIS-enabled PDFs.

Federated systems, which join together server technologies
for collaborating and sharing information across
organizations."
Dangermond continued, "These three patterns provide a
foundation for a fourth patternWeb GIS. This pattern
provides new opportunities for leveraging your work
through Web applications. It is about harnessing the power
of the Web with all the power of what you do in GISgoing
far beyond simple mapping or visualization and ultimately
becoming a part of society's infrastructure. GIS
professionals will be implementing this infrastructure by
authoring and serving knowledge, maps, and visualizations
as well as analytic interpretations and authoritative
applications. These will be consumed by casual users
leveraging our collective knowledge."

Prediction of growth was modeled using the new Geographically
Weighted Regression tool for statistical analysis. Michael Parkin of
MIT demonstrated 3D visualization improvements through an
impressive campus facility management application. An ESRI
technician explained values rendered from an ArcLogistics analysis,
which modeled how organizations could save hundreds of
thousands of dollars using intelligent fleet management strategies.

group, ESRI expressly acknowledges 150 outstanding users by
conferring its Special Achievement in GIS award. “At ESRI, we are
always deeply impressed by the innovation of our users," says Jack
Dangermond, ESRI president. "We want to recognize the efforts of
these individuals with our Special Achievement in GIS Award. This
recognition is well deserved for how they've applied geospatial
technology to address the needs of their industries and
communities. They are defining GIS best practices."
Reliance Energy, Ltd., in Maharashtra, India, has demonstrated its
vision and leadership, using ESRI's geographic information system
(GIS) technology to better serve the world. To recognize this
passionate approach to applying GIS solutions, ESRI Inc presented
the organization with the Special Achievement in GIS (SAG)
Award.

ArcGIS Server Drives WebGIS

Reliance Energy is India's largest integrated private sector power
utility company that manages the generation, transmission,
distribution, and trade of power. To improve efficiency for its four
million customers, the utility chose to implement Miner & Miner's
ArcFM solution, based on ESRI's ArcGIS software, for their Mumbai
and Delhi Electric Distribution System. Today, more than 1,500
Reliance users access utility network data through ArcIMS
technology from any place at any time.

ArcGIS Server improvements were dramatized via working

ESRI Awards
In addition, Dangermond presented specific awards during the
Plenary. The Enterprise Application Award was presented to the
State of Qatar, Centre for GIS for its holistic integration of GIS
across the country. This was accepted by Mohamed Abd Elwahab
Hamoud.

President Awards
The President's Award was given to the City of Philadelphia for
multiple uses of resources and data. It was accepted by Jim Querry,
director of enterprise GIS.

GIS for Sustainable World
Delivering the Keynote address Dr. Peter H. Raven, president
of the Missouri Botanical Garden, where he described the
environmental diversity of the planet and the challenges for
humans to live in a sustainable world. He illustrated the
many problems we face with growing populations, altered
landscapes, over-consumption, and climate change. These
are rapidly altering the face of our environment.
The Garden's research scientist Dr. Trish Consiglio explained
how the research lab uses GIS to put its enormous database
to work by combining grid analysis, verifiable identification,
and regression computation within GIS. From this, she
presented a model for predicting species relationships
within areas where little is known.
Raven concluded, "Technological tools, such as GIS, bring
to bear a proper understanding of these problems and a
proper solution. It helps us in our endeavors to develop love
and concern for other people. These tools equip us to turn
from passivity toward active engagement in developing
much needed solutions."

ESRI Technology Update
New updates on the functionality and capability

scenarios. A federated pattern of shared applications and data was
applied within a situational setting in Louisville, Kentucky, that
described how new-generation Web 2.0 principles and practices
engender Web-based communities of hosted services. This, in turn,
gives rise to the capabilities to use content from multiple map
services and create mashups for ad hoc, federated, and enterprise
applications.
Integrated GIS and image server technology was demonstrated
using German applications from the Bavarian Forest Service and
the Hamburg Fire Department. The integration allows GIS users to
perform dynamic processing in the server, serve it up to an image
service, and deliver it into a standard GIS for display, analysis, and
visualization.

Making Difference Award

Special Achievement Awards

The Making a Difference Award honored two recipients. The first
were Rósario C. Grustide Pérez and Ramón A. Pérez for research
about urban poverty in the barrios of Caracas.

The most important component of a successful GIS is not the
software but rather the people who use it. “In 2008,” said
Dangermond, "one-quarter million organizations used ArcGIS in
their work, which has been a spectacular endeavor. From this

The second was awarded to the U.S. Department of the Interior
Secretary Dirk Kempthorne who announced the USGS' latest
action to make 35 years of Landsat information freely available for
worldwide consumption.

GIS Awards
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ESRI Honors GIS Innovators in
Health and Human Services
Individuals and organizations that promote the use of geographic information system (GIS) technology in health and human services recently received
recognition from ESRI, the world leader in GIS technology, for their contributions. The awards were announced during the 2008
ESRI Health GIS Conference held in Washington, D.C., September 28October 1. "These exemplary people and
organizations set the bar and inspire all of us to do better in our daily work," said Bill Davenhall, global manager
for health and human services, ESRI. Receiving awards were the Alabama Department of Children's Affairs
(ADCA); Pat Libbey, executive director of the National Association of County and City Health Officials
(NACCHO); Bruce Ripley, Planning Systems Support Group, Veterans Health Administration (VHA)
received the award posthumously; and the Sault Ste. Marie Innovation Centre, Canada for
Communication Srvice.
ADCA received the Vision Award, who demonstrated foresight in the implementation
of GIS to enhance communication, collaboration, and data sharing through
development of its Alabama Resource Management System. The system uses GIS
to integrate data from more than 20 health and human service agencies and
make it available over the Web. As a result, it connects decision makers in
agencies, programs, and communities with the information they need to
evaluate community needs and plan and implement solutions that
improve the lives of children in the state.
The Service Award recognizes individuals who do an outstanding job
of advocating GIS technology and helping others understand its
value and purpose in their everyday work. In his role as NACCHO
executive director, Pat Libbey has provided leadership for more
than 3,000 local health departments across the United States. "In
tracking, mapping, and identifying the social determinants of
health, I think we all recognize that the practice of public health
has as its core the spatial distribution of elements that contribute
to our health as well as take away from it," commented Libbey.
"Thank you, ESRI, for the support that you give to improving
public health in this country and throughout the world."
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Keynote from DHL Express Europe to Kick Off 2009 ESRI
Business GIS Summit

With approximately 285,000 employees doing business in more than 220
countries, DHL International is the largest logistics provider in the world. "GIS
is used at DHL every day, and it makes a real difference to our business," says
Dahlin. "By using this technology, we've optimized our transportation network
and given our customers reliable delivery timetables. This gives us improved
margins and allows us to respond to changes in our marketplace quickly."
The ESRI Business GIS Summit, now in its sixth year, attracts business GIS professionals
from more than 30 industries and market sectors. It is recognized as the leading conference for
collaboration and networking regarding the application of GIS to retail, real estate, insurance,
manufacturing, media, logistics, and general commercial business processes. The summit combines
best practice sessions and roundtable discussions with user presentations, technical workshops, and an
education program sponsored by the University of Redlands, California. For more information about the summit
and to register, please visit www.esri.com/bizsummit.
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For more information on GIS in health and human services visit
www.esri.com/health.

Henrik Dahlin of DHL Express Europe will keynote the ESRI
Business GIS Summit being held May 4-6, 2009, at the Westin
Tabor Center in Denver, Colorado. Dahlin will discuss how
geographic information system (GIS) technology has helped the
international company improve its bottom-line results, boost
customer service ratings, and reduce its impact on the environment.
A Presentation to Detail How Geographic Business Intelligence
Increases Profits, Improves Customer Service, and Creates
Environmentally Responsible Organizations

10. Interview

Corporate Office:
NIIT GIS Limited, 8, Balaji Estate, Sudarshan
Munjal Marg, Kalkaji, New Delhi 110019
Ph.+91(11) 26203840, 26203801, Fax: +91(11)
26203838
Regional Offices:
NORTH-I & NORTH-II : NIIT GIS Limited, 8, Balaji
Estate, Sudarshan Munjal Marg, Kalkaji, New
Delhi 110019 Ph.+91(11) 26203823, 26203834;
MUMBAI : 1st Floor, Wing - A, Marwah Centre,
Krishanlal Marwah Marg, Off Saki Vihar Road,
Andheri (East), Mumbai 400072 Ph.
+91(22)40103175; 40103172; AHMEDABAD :
3rd Floor, Crystal Arcade, Near Navrangpura
Telephone Exchange, C.G. Road, Ahmedabad
380009 Ph: +91(79)26463032; KOLKATA : 6B,
Pretoria Street, Kolkata-700071 Tel :+91(33)22821535,22821708 / 3156; HYDERABAD : 3rd
Floor, Prashanti Complex, Basheerbagh,
Hyderabad-500063 Ph. +91(40) 23231567,
23240434, 55633616; BANGALORE : 4th floor,
Ramakrishna Towers, 31/2 Rupena Agrahara,
Begurhobli, Hosur Road, Bangalore South Taluk,
Bangalore-560058 Ph. +91(80) 30289500,
30289652(D); CHENNAI : 104, Cathedral Road,
Chennai-600086 Ph:+91(44) 43510957/56

Optimizing Resource Utilisation using GIS

Rajesh C Mathur
President, ESRI India

Back in 1982 the World Bank said the global economy will enter into recession and the
international trade will also decline by 2007. The subprime crisis that emanated from US
has slowly spread its wings across the world. Indian economy has also been affected by the
global developments and our capital markets have taken a big hit in the last few months.
Some of the sectors that have been severely affected include textile, real estate, retail,
financial services, among others. Indian corporate houses are under pressure to reduce
costs and increase employee productivity in order to maintain their profitability.

While we all know that economic recession is upon us and a lot of media hype every so often compels us to press
the panic button, the need of the hour is to take advantage of suitable technology for optimizing our resources
and be more prolific, thereby gearing up for times ahead which might be even more difficult. There are several
areas where GIS can help organizations in optimizing resource utilization and enhancing staff productivity.
GIS can help the industry in optimizing transportation and logistics costs by using it in vehicle routing leading to a
more effective fleet utilization and also reducing fuel costs. Apart from reducing transportation costs
organizations will also contribute in improving the environment by reducing the number of vehicles on the road.
Business houses can also apply GIS to demographically profile their customers using geography as the key
parameter leading to more focused marketing and retailing. The industry can use GIS to identify the site for their
next retail outlet keeping in mind their target market and geographic spread of the customers. They can also use
GIS to decide which stores to close during challenging times.
Utilities can apply GIS to improve planning and management of their network. It helps power utilities in reducing
Aggregate Technical and Commercial (ATC) losses. Utilities use GIS to enhance revenue realization by interfacing
GIS with the automated meter reading systems. They are also applying GIS based outage management systems
like Responder from Miner & Miner to better manage power outages thereby enhancing network utilization
leading to improved revenues.
GIS can help agriculturists in enhancing farm yield by planning the next crop based on soil, water availability, and
agro-climatic conditions among others. It can also help in identifying wastelands which can be recovered and
developed. Thus, GIS has the potential to not only increase agriculture capacity but also improve yield.
GIS also plays an important role in planning and management of infrastructure projects like Transportation, Law
Enforcement, Urban Development among others. Municipal Corporations are deploying GIS to build and
manage database of property owners which would lead to significantly enhanced property tax realization. City
administrators can apply GIS in development and management multimodal transportation networks leading to
optimal utilisation of the transportation system thereby reducing transportation time and costs for the citizens.
These are just a few examples of how Geographic Information Systems have the potential to help corporate
houses, government departments, utilities, local governments et al in better management of their costs as well as
improved resource utilisation thereby containing the adverse effect of the slowdown on their organisations. ESRI
has the required technology to support institutions in building enterprise GIS solutions for this purpose.
The future can be very positive if we can take the appropriate actions.
I wish all of you a very prosperous new year and success in your endeavours during these challenging times.
We can all succeed!
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Alliances
Reliance Energy Limited wins ESRI SAG Award

I would like to congratulate
ESRI-INDIA for bringing out
ArcIndia News. Apart from a
very great look, it provides a
lot of new ESRI technologies.
The magazine is a great
literature providing an
overview of the development
in geospatial technology & its
application. I especially liked
the idea of Tips and Tricks and
the technical articles. Apart
from this, it also provides a
platform for people to learn
about how various ESRI
solutions are being
implemented across
organizations in India and
abroad. The magazine covers
a good mix of case studies,
accomplishments, product
information and technology
inputs, all of which are very
essential in the emerging
Indian GIS market scenario,
where the user community is
constantly confronted with
the challenge of deriving
business process
improvement through
effective implementation of
GIS technologies .

"I really appreciate
ESRI India for
publishing ArcIndia
News which is
extremely thoughtful
publication and
provide in-depth
insight about ESRI
technologies.
More sector specific
Case studies, their
GIS implementations
and articles on Real
Estate, Urban
Planning etc. can be
included to make it
more effective."
Rajnesh Mago
Project Manager,
GIS , DLF

Reliance Energy is India's largest
integrated private sector power utility
company that manages the generation,
transmission, distribution, and trade of
power. To improve efficiency for its four
million customers, the utility chose to
implement Miner & Miner's ArcFM
solution, based on ESRI's ArcGIS
software, for their Mumbai and Delhi
Electric Distribution System. Today, more
than 1,500 Reliance users access utility
network data through ArcIMS

technology from any place at any time.
The hallmark of Reliance Energy's
enterprise-wide GIS implementation is the
integrated approach. Reliance's IT
department has successfully made their GIS
a workspace for all field processes, from
operations and maintenance to planning.
The interface of GIS with other key systems
helps utility managers and executives find
new ways to optimize operations, increase
work efficiency, and improve business
processes.
“At ESRI, we are always deeply impressed
by the innovation of our users," said Jack
Dangermond, ESRI president. "We want to
recognize the efforts of these individuals
with our Special Achievement in GIS
Award. This recognition is well deserved for
how they've applied geospatial technology
to address the needs of their industries and
communities. They are defining GIS best
practices."
Rajendra S Pawar receives Geospatial
Entrepreneur of the Year Award
Geospatial Today concluded its Annual

Special Event of Indian Geospatial
Awards, Survey 2008 release and round
table discussion on 25th April, 2008 held
at Hotel Le Meridian, New Delhi. Mr.
Rajender Singh Pawar, Chairman, NIIT,
was conferred with “The Geospatial
Entrepreneur of the Year Award” in this
event. This Award is presented to an
entrepreneur of Indian Geospatial
company in recognition of his/her
achievements, excellence and innovation.
This Award is based on the success and
efforts of the individual towards
increasing employment, developing
innovative business methods and
economic growth.

In all, I found all the articles
interesting and quite a focus
on Indian examples.
Keep it up !!!
I C Matieda
Manager, CFB/MOG
Space Application Centre

Satyajit Dash
GIS Specialist CAIRN INDIA

The editorial board members
would like to get feedback
from ESRI user community
about ArcIndia News.
Kindly send your feedback to
fb_ain@esriindia.com
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ArcIndia News is a long
awaited medium for Indian
GIS users and is a very good
initiative which focuses on
latest technology trends in
GIS and provides extensive
depths for Indian articles. I
am specially impressed by the
section which covers insight
into how ESRI GIS
Technologies has been
implemented by different
organizations and shared
their experiences. I
congratulate ESRI India for
this great effort. I would
recommend inclusion of
some more advanced
technical articles & Case
Studies for providing more
indepth knowledge.

San Diego, CaliforniaReliance Energy,
Ltd., in Maharashtra, India, has
demonstrated vision and leadership,
using ESRI's geographic information
system (GIS) technology to better serve
the world. To recognize this passionate
approach to applying GIS solutions, ESRI
presented the organization with the
Special Achievement in GIS (SAG) Award
on August 6, 2008, at the 28th Annual
ESRI International User Conference (ESRI
UC) in San Diego, California. The award
was received by Mr. Uday Kale and Mr.
Harsh Sharma of Reliance Energy.
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ArcLogistics
Save money and Improve your fleet efficiency

Production Line Tool Sets (PLTS)
An Efficient GIS Database and Map Production Tool
The Production Line Tool Sets (PLTS) are powerful, easy-to-use
collection of software applications that provide efficient
production and maintenance of digital cartographic databases.
These streamlined processes allow users to create, manage and
exploit multiple map product databases with increased quality at
a lower cost. PLTS operate on top of standard ESRI software,
providing tools designed to facilitate high-quality database
production and cartographic output.
While being developed to produce standard National Imagery
and Mapping Agency (NIMA) products, including digital data,
PLTS leverages object-oriented ArcGIS Desktop technology to
provide a “next generation,” functionality rich software suite
that streamlines the management and semantics of production.
The fundamental architecture of PLTS for ArcGIS provides users
the ability to implement their own business rules in data
modeling, attribution, validation, and output with PLTS
Foundation.
The PLTS product line consists of several components
representing major functionality groups and several "Solutions"
representing the major vertical markets. Collectively, the three
PLTS components are packaged and sold together under the
product name "PLTS Foundation for ArcGIS". Currently, there
are three main PLTS components
(Foundation Tools, GIS Data
Reviewer, and MPS-Atlas) and five
"Solutions" (Defense, Nautical,
Mapping Agency, Intel Agency,
and Aeronautical). The tools have
evolved into simple, easy-to-use,
menu-driven components that
form a highly integrated system
that enables geospatial data
production.
Industry specific business rules and data models have been built
on top of PLTS Foundation to make up each of the PLTS
solutions. These commercial off-the-shelf solutions enable
organizations to efficiently produce geospatial data while
adhering to industry specific production requirements. In
addition, quality control, cartographic product generation, and
work flow management components are included within PLTS
Foundation and are also available separately.

Key Features
PLTS were developed within the ESRI Services Production group
on actual production projects. The database-centric approach
enables the creation, maintenance and output of reliable, costeffective digital data and cartographic products with following
features:
= COM-compliant technology
= Customizable objects and user interface
= Robust cartographic capabilities
= In-process QC validation of attributes during editing
= WYSIWYG cartographic editing
= Custom renderer and on-the-fly symbology
= Integrated quality control tools

8

Project and Map Sheet Database

Introduction

Sources, production areas and output products are organized
and managed spatially in a geodatabase. This database houses
source information in the form of hardcopy, vector and imagery
data. It provides a catalog, repository and server for assigning
production work orders. Finally, it is used to leverage digital
data products and hardcopy maps from the geodatabase for
publishing.

Logistics in GIS technology meet a specific business need,
bringing information to life in a way that is both visually
impressive and analytically sophisticated.

Geodatabase Editing Environment

ESRI's ArcLogistics a proven product built on the ArcGIS
platform, will help users to improve their daily fleet operations to
achieve an optimum level of performance in concern of
businesses and local governments as they seek to optimize the
performance of vehicle operations to save fuel, reduce labor and
maintenance costs, and operate in a more sustainable manner.

PLTS streamline ArcGIS with single-click editing tools and
extensions of geodatabase domains. Highly accurate
geospatial data is created and maintained using menu-driven
attribution tools. These attribution tools utilize user-defined
integrity rules and behaviors, on-the-fly attribute validation and
in-process database Quality Control (QC).

ArcLogistics is used for building efficient routes and schedules in
a multistep / multivehicle environment using variables that reflect
user's operational workflows with following application.

Database-Driven Cartography

=

Data produced can be used for high-quality cartographic
output through the use of the Map Production System (MPS).
MPS is a customizable, database-driven cartographic
production environment within PLTS. A single production
database can be used for multiple cartographic products by
employing different symbology schemas. Symbology is driven
by attribute tables and map series definitions. This databasecentric approach simplifies and facilitates product generation
and maintenance, ensures data consistency and enables map
series production

=
=

=

PLTS for ArcGIS operate on top of ArcGIS software. The
hardware configuration requirements for PLTS for ArcGIS are
the same as those for the core ESRI software packages.
Supported hardware operating environments:
Hardware Platform: PC Intel
Operating System: Microsoft Windows 2000 or Windows XP
(Home Edition and Professional)

Production Line Tool Sets (PLTS) ….Who will use?
PLTS extends ArcGIS for National and defense mapping
organizations by turning their standard, static products into a
single enterprise-wide database, giving them flexibility to
serve any number of digital and hardcopy cartographic
products.PLTS enable organizations to perform:
=
Aeronautical Charting
=
Cadastral/Parcel Mapping
=
Census Mapping
=
Defense Mapping
=
Forestry/Natural Resources Mapping
=
National Spatial Data Infrastructure Development
=
Nautical Charting
=
Topographic Mapping

=
=

=

Export routes to other ESRI applications
Integrates with Automatic Vehicle Location (AVL),
accounting, Enterprise Resource Planning (ERP), and other
enterprise technologies
Offers specific solutions for territory planning, route
balancing, and more from ESRI business partners

Determine which vehicle should serve each customer location
in the best stop sequence
Accommodate time windows while minimizing travel times
Find accurate customer locations and calculate efficient
routes
Optimize resources by accounting for individual vehicle
attributes (storage capacity, restrictions, special equipment,
etc.).

System Requirements
System Requirements

street-level directions, driver manifests, and more

ArcLogistics integrates easily with other ESRI products. Free plugins to the application are available to export routing results as a
network analysis layer for use in ArcGIS and ArcGIS Network
Analyst product. The hardware configuration requirements for
ArcLogistics for ArcGIS are the same as those for the core ESRI
software packages.

ArcLogistics Solution, who will use?
ArcLogistics solution gives the power and flexibility for fleet
management and delivery routing from your desktop in less time
while considering your business rules and processes in following
important application fields and many more.
Courier and Messenger Industry
=

Model Bids, Analyze Actual Operating Costs.

=

Schedule Routes for Optimized Results.

=

Preserve Matched Pairs in Efficient Routing.

Key Features

Food and Beverage Industry

ArcLogistics manage the fleet efficiently and reduce delivery
routing costs from a small fleet operation to a large multiuser
environment with following features:

=

Strict business rules or matched pairs, scheduling routes.

=

Optimize Vehicle and Staff Usage.

=

Plan and Maintain Geographical Sales Territories.

=

Includes high-quality data

=

Prompts you to set vehicle speeds over your street network

=

=

Builds optimized delivery routes based on actual network drive
times, not straight-line distances
Takes into account specialty of vehicles and drivers

Furniture and Business to consumer
=

Handle Customer Needs and Delivery Time

=

Make same-day changes to schedules

Utilities and Telecommunication
Maximize the number of service calls your technicians make
each day.

Imports customer orders from any Open Database
Connectivity-Compliant database

=

=

Geocodes customer addresses

=

Assign calls based on skill codes

=

Outputs route summary reports, detailed and overview maps,

=

Improve customer service through accurate scheduling.

=
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ArcGIS Business Analyst:
Map Your Way to Better Business Decisions
Introduction
All geographic information systems are built using formal
models that store spatial and non spatial data in a hybrid
integrated system. While the volume and complexity of the data
increases every day in corporate world, the organizations need
to enhance operational efficiency and delivery cost saving
using a Business Analyst geospatial software . It is a valuable
asset for business decision making and a complete solution for
site evaluation, selective customer profiling and trade area
market analysis. The Business Analyst makes it possible to
analyze data from your own client database along with external
public data in a whole new way to understand their clientele in
relationship to specific regions and develop more focused
marketing campaigns for its products.

Business Analyst Product Suite
Business Analyst is an affordable and scalable extension product
of server, desktop, and Web-based applications that can easily
be deployed throughout corporate world for improved
customer acceptance levels through mapping, analysis and
managing work. The product suits are:
=

ArcGIS Business Analyst Server

=

ArcGIS Business Analyst desktop software

=

Business Analyst Online

Key Features:
ArcGIS Business Analyst is an extension based on the world's
leading ESRI GIS. It allows the company to reduce its' marketing
costs and helps user to better understand the market, their
customers and competition with following Applications:
=

Choosing the ideal location

=

Identifying the customers and their buying habits

=

Customize and automate frequently used analyses

=

Evaluate existing stores and their product mix

=

Create sales territories

=

Targeting underserved markets

=

Select future business site

What's New in ArcGIS®
9.3 Service Packs
Main enhancements to ArcGIS® 9.3 added
by the service packs

To do this, start ArcCatalog™ and select the Tools > Options >
GIS Servers tab. Press the 'Clear Local Cache Now' button. You
can do this before or after installing 9.3 SP1. This can take a
few minutes to complete if the current size of your local cache
is large. You don't need to do this since your map documents
will continue to function correctly whether you do this or not.
In addition to reclaiming disk space, clearing the local cache for
all the cached map services you have used has the advantage of
ensuring that the next time you open a map that uses one of
these services, you'll be seeing the latest content for those
services. There have been a number of improvements to
several of the ArcGIS Online services since we released 9.3.

Perform site, competitive, and trade area analysis
=

Build interactive sales forecast and market share models

=

Create, edit, and manage sales accounts and service.

=

=
=

Develop and share reports with demographic, consumer,
and business data.

Export to CAD now at the ArcView License level

Discover up-sell and cross-sell opportunities.
Analyze the marketing strategies more quickly and
accurately.

Benefits:
=

Saves time and money

=

Promotes internal organizational efficiencies

=

Make better business decisions

=

Sales success by product, site, and sales representative.

=

Site locations of stores, factories, and warehouses.

=

Asset location (e.g., utility poles, pipes, and cables).

=

Resource locations of staff, products, and equipment.

services) in ArcMap™. When you use these services they get
cached locally on your machine in your system's TEMP folder as
you use them so that ArcMap doesn't have to request map tiles
from the server that you've already viewed. The issue in 9.3
causes multiple local caches to sometimes be saved for the
same map service. 9.3 SP1 fixes this so that only one local cache
is ever saved for a particular map service you access. If you have
used cached ArcGIS Server map services, such as ArcGIS Online
services, in your map documents, you may be able to free up a
lot of disk space in your TEMP folder by clearing all the local
caches.

General
Adds ability to export to Adobe Acrobat 9 PDF from ArcGIS
Desktop, Engine, and Server
Adobe® Acrobat® and Adobe Reader® version 9 support a new
version of PDF that allows for encoding of map coordinate system
and georeference information inside the PDF file.
Service Pack 1 for ArcGIS® 9.3 enables ArcGIS Desktop, Engine,
and Server applications to export georeferenced PDF files. When
a georeferenced PDF is opened in a compatible viewer, such as
Adobe Reader 9, the user can access geospatial functions such as
coordinate readout and find XY.
After installing the service pack, the new PDF export functionality
can be controlled in ArcGIS Desktop via a new checkbox in the
Export Map dialog box's PDF format Advanced options panel.
Installing the service pack on ArcGIS Server or ArcGIS Engine will
enable map georeference output by default. Export of
georeference info during Server or Engine export can be
suppressed via ArcObjects™ by setting the IExportPdf2:
ExportMeasureInfo property to false. Export Map dialog and the
new 'Export Map Georeference Information' checkbox:

In 9.3 Service Pack 1, the geoprocessing tool Export to CAD has
been moved to the ArcView® license level. The other CAD
helper geoprocessing tools in the To CAD toolbox (Add CAD
Fields, Set CAD Alias, and Create CAD XData) have also been
moved to ArcView license levels, since they work with the
Export to CAD tool.

ArcGIS Server
Web Services
WFS 1.0 Support
In addition to the support for WFS 1.1 offered with ArcGIS
Server 9.3, the ArcGIS Server 9.3 Service Pack 1 supports the
WFS 1.0 to assist with interoperability. The WFS 1.0 support is
read-only and does not support transactions.

Progress indicator for map and globe caching
Map and Globe caching tools have a progress bar to help
estimate the approximate time it takes to complete a caching
job.

Note: This functionality was first released in a patch for ArcGIS
9.3 entitled 'ArcGIS (Desktop, Engine, Server) 9.3 Map Export
Patch to support Adobe Acrobat 9 PDF'.

ArcGIS Desktop
ArcMap Tip
One of the fixes in 9.3 SP1 corrects an issue with using cached
ArcGIS Server map services (such as any of the ArcGIS Online
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Careers at ESRI India
1. Role: Asst Project Manager / Project Manager
Experience: Should have 7+ years of experience in project planning and execution within planned time, cost and quality norms by ensuring
effective utilization of the allocated resource.

Skill Sets:
n
n
n
n
n
n

Knowledge of .Net, Java & J2EE
Should have sound knowledge of GIS Domain with specifically ESRI technology i.e ArcGIS Server, ArcGIS, ArcSDE, ArcIMS
Should be hands on with full GIS project life cycle experience
Experience of team handling, task management and process management
Solution Architecting and developing project plans.
Scoping - determining scope, write scope documents and SOWs

Soft Skills:
n

Should have good communication skills with experience in managing teams & handing customer requirements

2. Role: GIS Engineer / Sr. GIS Engineer
Experience: Should have 2-7 years experience in GIS

Skill Sets:
n
n
n
n
n
n
n
n

Knowledge of .Net, Java & J2EE
Working level experience on different OS/Hardware Platforms viz. Windows/Intel,
Should have sound knowledge of Database / RDBMS like Oracle, MS SQL Server
Should have sound knowledge of GIS Domain with specifically ESRI technology i.e ArcGIS Desktop
Should have awareness of various WebServers like IIS, Apache tomcat, etc.
Sound fundamental knowledge of Network Communications(TCP/IP, http, https, etc.), Client Server Architecture
Should have good communication skills with experience in managing customer interactions & handing customer requirements
Should have inclination towards customer technical support services.

Responsibilities:
n
n
n
n
n
n
n
n
n

Technical Support
To ensure that the technical support calls from the clients in the entire region are handled by the technical services team in the
region as per the QMS goals/ SLA's defined.
To attend to technical support calls and resolve them as per the QMS goals / SLA's defined.
To provide onsite technical support
To Install products in a heterogeneous environment
To set up testing environment.
Trainings
Pre Sales
To demonstrate software functionalities to customers

3. Role: Business Executive / Sr. Business Executive
Experience: 2 to 6 years of experience in selling IT services and solutions/ Telecom.

Skill Sets:
n
n
n
n
n
n

Should have handled Large Corporate and Govt. Accounts.
Establishing and developing large government accounts, new account development and channel development.
2 years experience in managing large accounts. Exposure to IT / Telecom-/ software product sales, Systems Integration is a must.
GIS market understanding shall be preferred.
Should have high target Orientation & result orientation
Excellent communication skills and interpersonal relationship

e-mail your resume to gistalent@esriindia.com or send it through post to:
Head, Human Resource, ESRI India
8, Balaji Estate, Sudarshan Munjal Marg, Kalkaji, New Delhi - 110 019, INDIA.
Kindly mention the position applied for and your current location in the subject line.

